Envirocar Programming
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Using Great Cow Graphical BASIC

Contents
Great Cow Graphical BASIC Cheat Sheet


Essential tips to refer back to if you forget them.

Exercise 1: Flashing a light


Pulse the headlights of the Envirocar to show it working

Exercise 2: Driving in patterns


Make the Envirocar drive in a predefined pattern.

Exercise 3: Envirocar-in-a-box


Program the Envirocar to jump out of a cupboard when the door is opened.

Exercise 4: Following a line


Follow a line marked on a table, using the light sensor to detect the line.

Exercise 5: Improved line following


Make the line following more accurate.

Exercise 6: Counting button presses


Flash the light the same number of times as the button is pressed.

Exercise 7: Combining the programs


Combine the button counting, Envirocar in a box and line following programs, so that you can choose a different program by pressing the button.

Introduction

These exercises will introduce you to programming, and allow your Envirocar to do things by itself.

Exercises 1 through 5 are simpler ones that will introduce you to the various parts of the Envirocar; while exercises 6 and 7 will cover some more advanced programming concepts.

Throughout the manual, there are some sections in italics. If you’re in a rush you can skip them, but reading them will give you a much better understanding of various things.

While doing these exercises, don’t be afraid to experiment! And if you make a mistake, don’t feel bad about it – making mistakes is the best way to learn!

Great Cow Graphical BASIC Cheat Sheet

The most important parts of the GCGB window:
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Basic method for adding an icon:

1. Select the Icon Category.

2. Drag out the required icon and drop it into the program.

3. Adjust the Icon Settings so that the icon does what it should.

If you make a mistake you can easily undo it by clicking Undo on the Edit menu.

Sending a program to the robot:

1. Click on the Tools menu

2. Click Compile and Download With

3. Click on the programmer you are using.

Common Mistakes:

· Make sure you have the Envirocar library added

· Make sure that the microcontroller chip is fitted to the robot

· Make sure that the programmer is connected and working

Exercise 1: Flashing a light

Aim:

The aim of this exercise is to make the headlights of the Envirocar flash. This will test that the chip has been inserted properly, and that it can run a program. It’ll also show how to create a simple program.

Step 1:  Creating a new program

The first thing to do is to create a new program. Normally, this is done when you open Great Cow Graphical BASIC. However, if you have done anything since opening GCGB, you will need to create a new program.

To do this, click on the File menu and then click New.

The window should now look like this:
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Click on the File menu, and then click Save. Save your program somewhere so that you can refer to it later. If you save your program now, any changes will be automatically saved later when you send the program to the robot.

Adding the library

Next, the Envirocar library must be added. This is a special file that gives GCGB the information about the Envirocar that it needs, like what sort of chip it is programming and what things are connected to the chip.

Click on the Program menu, and then click Libraries. This window will appear:
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This shows all of the libraries that are currently added to the program, or that can be added. You may have slightly different libraries – all that matters is that you have envirocar.h.

In the Included Libraries list, click on <envirocar.h>. Then, click the Add > button next to the list (the one circled below). The <envirocar.h> file will appear in the Current Libraries list. 

The Libraries window should now look like this:
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Click OK to close the Libraries window.

Step 2:  Adding the Pulseout icon

Now, an icon to make the headlights pulse on is needed. There are a few icons or combinations of icon that can be used to do this, but the easiest to use is the Pulseout icon. The Pulseout icon affects an output of the microcontroller chip, so it is in the Input/Output icon category. 

The Icon Category will probably be set to Flow Control. Click on the down arrow next to Flow Control, and change it to Input/Output. The window should now look similar to this: (The Icon Category has been circled.)
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Now, the Pulseout icon can be added.

To add an icon, drag it out of the Available Icons list, and drop it into the program. It can be dropped on top of, underneath, onto the arrow or to the side of the icon it is to be placed after. The Pulseout icon needs to run after the program starts, so it must be placed after the Main icon.

If you’ve never dragged and dropped before, this is how to do it:

1. Move the mouse over the icon to drag (Pulseout)

2. Press down on the left button and hold it

3. Without releasing the left button, move the mouse to where you want the icon to go (under the Main icon).

4. Let go of the left button

The program should now look like this:
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Step 3:  Setting up the Pulseout icon

Notice how the Icon Settings area (on the right hand side of the screen) has changed. This makes it possible to alter the settings for the Pulseout icon, which control what it pulses and how long it pulses for.

In this case, the Headlights need to be pulsed for 1 second.

First, IO Pin will be set. This tells Pulseout what to pulse. Clicking on the down arrow for the box under IO Pin will show this list:
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Find Headlights in the list (it’s near the bottom), and click on it.

Next, click in the Time Length box, and type the number 1.

Finally, choose s from the Time Units box. When Time Length is 1 and Time Units is s, the Pulseout icon will pulse for 1 s, or one second.

(A side note: GCGB doesn’t allow the use of decimal points in Time Length. If you want to make the headlights flash for half a second, you type 500 into the Time Length box, and then choose ms in the Time Units box. This would give a pulse of 500 milliseconds. 1000 milliseconds is a second, so 500 ms is half a second.)

With the Pulseout icon added and set up, the program should look like this:
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Step 4:  Sending the program to the robot

Now that the program is written, it must be transferred to the Envirocar.

To do this, a device called a Programmer is used. A Programmer usually has two plugs on it: a plug that connects to the robot, and a plug that connects to the computer (usually to a USB port). 

There are two brands of programmer that are normally used with the Envirocar. One is the Microchip PICkit 2 programmer, and the other is the eLabtronics USBP programmer. There are pictures of these two programmers on the next page.

Regardless of which programmer you are using, you need to:

1. Connect the programmer to the robot

2. Connect the programmer’s USB cable to a free USB port on your computer

3. If any messages come up about installing new hardware, wait until the message goes away before you try to do anything.

If you are using a Microchip PICkit 2, the programmer should be connected like this:
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If you are using an eLabtronics USBP programmer, the programmer should be connected this way:
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Once the programmer is connected, GCGB must be told to download the program to the robot. To do this, click on the Tools menu, then on Compile and Download with, then click on the name of the programmer you are using. This picture shows where you need to click:
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(The first item shown, IC-Prog, is for another type of programmer that isn’t used with the Envirocar. Your copy of GCGB may include even more programmers – just ignore them unless your teacher or mentor tells you that you need to use them.)

If you’re using the Microchip PICkit 2, a small black window will appear for a few seconds. The lights on the PICkit 2 will flash, and then the window will close. The program will now be on the Envirocar! Skip ahead to the Result section.

If you have an eLabtronics USB programmer, the process is a bit more complicated. This window should appear:
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If this window appears and there is no red bar at the bottom, then click on the Write button (circled). The bar at the bottom should change, and after a few seconds this should appear:
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Note the bar at the bottom of the window. If it’s green, the program is now on the Envirocar! Close the USB Programmer window, and then the program can be tested. Please skip ahead to the Result section.

If the bar at the bottom is red, then there has been some problem programming the robot. If this appears when you click on the Compile and Download With menu, there is a problem:
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If this happens, try closing the USB Programmer window. Unplug the USB Programmer from your computer and count to 30. Try disconnecting the 3 white wires that connect the boards of the robot together. Plug the USB Programmer back in, and try clicking on the Compile and Download With menu again. If it still won’t work, ask your teacher or mentor for help, or get a new programmer.

Result:

If all went well, the headlights of the Envirocar should turn on when the power switch is turned on. Congratulations, you’ve written a program!

If it did not work, check that:

· The headlights worked when tested during the construction of the robot. (This is something that should have been checked during assembly)

· The batteries are good

· The 8 pin PIC12F675 chip is fitted to the chip socket

· The PIC12F675 is installed in the socket facing the correct direction.

If it still doesn’t work, don’t be discouraged! Ask your teacher or mentor to check over your robot and program. Just like writing something, it’s very easy to make a simple mistake and not notice until someone else looks at it and sees the problem straight away!

Exercise 2: Driving in patterns

Aim:

In this exercise, we’ll make the Envirocar drive around. We’ll first make it drive forward for a second, then drive forward for a second and turn, and then we’ll make it drive in a zig-zag pattern.

Step 5:  Making a new program

Before we start adding icons, it’s important to create a new program. As a reminder, these are the basic steps:

1. Click File and then New to make a new program

2. Add the Envirocar library

3. Save the new program somewhere safe (click File and then Save)

If you need help remembering how to do anything, have another quick look at Exercise 1.

Step 6:  Flashing the headlights

Before it drives off, the Envirocar should flash its headlights for a second. Use the Pulseout icon to make the lights flash, like we did in steps 3 and 4 of Exercise 1.

Step 7:  Driving forward

Now, we will make the Envirocar drive forwards.

How do we do this? The Envirocar library contains some special icons that make the Envirocar drive. To see these icons, we need to set the Icon Category to “Library: envirocar.h”. This will be near the bottom of the category list, and has several green icons in it as shown on the next page.

An important warning: If you turn on the motors straight away in your program, they will try and turn on when the computer tries to download a new program to your robot. This might make it hard to download a new program! Never make the motors turn on at the very start of the program!
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Now, find the Forward icon in the list, and add it to the program:
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The Forward icon has no settings that need to be set. It will turn on the motors, and then leave them on until another icon turns the motors off.
Step 8:  Waiting for 1 second

Now that we have told the robot to start driving forwards, we need to make it wait for a second before stopping.

To make the robot wait, we use the Wait icon. This is in the Flow Control category. Once you’ve added the Wait icon, the program should look like this:
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Change the settings of the Wait icon so that it will wait for 1 second. (Clue: The settings for the Wait icon are very similar to the settings for the Pulseout icon.)

Step 9:  Stopping

The Envirocar will start driving forwards, and then wait for 1 second. Next, we need to tell it to stop.

To make the Envirocar stop, we use the Stop icon. Since this icon is for the Envirocar only, it’s in the “Library: envirocar.h” icon category. Add the Stop icon to the end of the program. The program should now look like this:
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Step 10:  Downloading the forward program

Your program should now look like the one above. Download it to the robot (have another look at Exercise 1 if you’ve forgotten how to do this), and see what happens!

The robot should flash the headlights for a second, and then drive forward for a second.

Step 11:  Turning around

We’ll now add to the program to make the Envirocar turn left for half a second after it has driven forward for a second, but before it stops.

To do this, we’ll use the TurnLeft icon, and put it in the middle of the program. The TurnLeft icon is in the “Library:envirocar.h” category. Drag it out, and then drop it onto the icon above where it should go. This should be the Wait 1 s icon.

Next, drag out another Wait icon. Drop it onto the TurnLeft icon, so that it is added after (below) it.

We want the robot to turn for half a second, so the Wait icon will need to delay for half a second before the Stop icon. How can we make this happen? As noted briefly in Exercise 1, we can’t use decimal points in the Pulseout or Wait icons, so we have to use a delay of several milliseconds.

How many milliseconds? There are 1000 milliseconds in a second, so half of a second is half of 1000, or 500 milliseconds. Type 500 into the Length box, and choose ms for the units.

The program should now look like this:
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(Note that program is scrolled down, so the Main icon and the Pulseout icon are out of sight.)

Step 12:  Downloading the forward then turn program

Download the program to your Envirocar. It should:

· Flash the headlights for a second

· Drive forward for a second

· Turn left for half a second

If your Envirocar doesn’t do any of these things, double-check your program. If it’s correct, then you may need to ask your teacher or mentor to check your Envirocar for faults.

Take a moment to observe how the Envirocar turns corners; it will be important that you remember this later on. It doesn’t move its front wheels like a car; instead it stops running one of the motors. It will then turn toward the side with the stopped motor.

Step 13:  Making the Envirocar zig-zag

Now, let’s alter the program so that instead of going forward for a second, the Envirocar first turns right for a second. Then, it’ll run the icons to make it turn left, which will make it do a zig-zag.

The first thing to do is to remove the Forward icon. Click on the Forward icon, and then press the Delete key on your keyboard. This will remove the icon.

Next, drag out a TurnRight icon from the Envirocar library. Put it where the Forward icon was, by dropping it onto the Pulseout icon.

Finally, change the Wait icon after the TurnLeft. Alter it to change the 500 millisecond delay into a 1 second delay.

The program should now look like this:
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Download this program to your Envirocar, and check that it works.

Step 14:  Making the Envirocar zig-zag over and over again.

How could the Envirocar be made to zig-zag repeatedly?

Of course, it is possible to copy and paste the same icons over and over again, but then what if you wanted to change the length of time it spends moving in each direction? You’d have to edit every single Wait icon. Plus, with all those icons, the Envirocar would run out of memory very soon! (It only has 2 kilobytes of memory to store a program; luckily most icons only take a few bytes!)
The best way to make it do something over and over again is with the Do loop.

Change to the Flow Control icon category. Drag out the Do icon, and drop it under the Pulseout (before the TurnRight). The program should now look like this:
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When you add a Do loop to a program, two icons are added – a Do icon, and a Loop icon. Everything between those icons is run over and over again.

Note the Mode setting in the picture above. This controls how long the Do loop will loop for. When you first add the Do icon the mode it is set to Forever, which means that the icon will repeat over and over again until the power to the robot is turned off. There are a couple of other modes that will make the icons inside the loop repeat until something happens, but we don’t need them right now.

There is a slight problem with the program shown above; there is nothing in the loop! To fix this, we need to move the Loop icon to the end of the section of icons that we want to repeat. Click on Loop to select it, then drag it down and drop it before the Stop icon.

Delete the Stop icon, because we won’t need to stop. The Envirocar can keep on zig-zagging.

Your program should now look like this:
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Step 15:  Downloading the zig-zag program

Download the program to make the Envirocar zig-zag over and over again. Does it work?

You might find that the Envirocar tries to change direction too often. If it does, try some different Wait icons. You might try telling it to wait for 2 or 3 seconds. Or, tell it to wait for 2.5 seconds (remember, no decimal points so you’ll have to write this as 2500 milliseconds).

Result:

The Envirocar should now be zig-zagging, and hopefully you’re familiar with some more icons in Great Cow Graphical BASIC. In the next few exercises, we’ll get the Envirocar to do something useful by responding to its surroundings.

Exercise 3: Envirocar-in-a-box

Aim:

In this exercise, we’ll program the Envirocar to perform a prank on unsuspecting victims. In the style of a classic Jack-in-a-box, we’ll make the Envirocar hide in a box or cupboard. When someone opens the door (or lifts the box), the Envirocar will see the change in light level, and drive forwards towards whoever opened the door.

Step 16:  Creating a new program

Create a new program. Add the library for the Envirocar, and save the program somewhere safe.

Step 17:  Waiting for light

The first thing that the robot needs to do is wait for light. To do this, we’ll use a Wait For icon  (not a Wait icon). Set the Icon Category to Flow Control, and find the Wait For icon. Drag it out, and add it to the program.

The program should now look like this:
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The two settings for the Wait For icon are a bit different to anything we’ve used before, so it’s important to have a look at what each one does.

The Mode of the command is either Until or While. We’ll come back to it in a bit.

The Condition is the trickiest part, so read this next bit carefully!
In Great Cow Graphical BASIC (and most other programming languages), a condition is a statement we make which may or may not be true. For example, one statement might be “Button = Pressed”. If the state of the button is equal to pressed, then this condition will be true. If the button is not equal to pressed, then the statement we have made is false, and so the condition will be false.

Since the state of the button can change (the button can be pressed or not pressed), the condition will be true sometimes and false at other times.

How does the Mode relate to this? If we set the Mode to Until, then the Wait For icon will wait until the condition becomes true. If we set the Mode to While, then the Wait For icon will wait while the condition is true, and then go to the next icon when the condition becomes false.

Set the Mode to Until. We will make the robot wait until there is light.

Next, we need to create a condition that will be true when the light sensor (the LDR) sees light. Click on the Edit button next to the box for Condition (circled on the right):

The first page of the Parameter Editor wizard will appear:
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(Note: Parameter is the technical term for a setting that programmers normally use.)

In this case, we need to compare two values. We want to check if the value from the light sensor is equal to a preset value (light). Click on Simple Condition, then click the Next button.

The next page of the wizard will open:
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On this page, we need to say what things we want to compare.

The first value we need to compare is the current light sensor reading. Click the arrow for the first value. A list of possible values will appear:
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Click on DigitalLDR in the list. This is one of the names given to the light sensor in GCGB.

Now, we need to set the second thing to compare. Click on the down arrow next to the second value. The same list will appear again. Some of the options in the list aren’t much use for comparing to a light sensor – the two most useful ones are LIGHT and DARK.

We want the condition to be true when the light sensor (LDR) sees light. So, for the second option, we choose LIGHT.

The Parameter Editor should now look like this:
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We now have a condition that makes sense! If the light sensor (DigitalLDR) sees (is equal to) light (LIGHT), then the condition will be true. Click on the Finish button to close the Parameter Editor and return to the program.

With all of its settings filled in, the Wait For icon in the program should now look like this:
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That is the hardest part of this program done; now we just have to add a few more simple icons.

Step 18:  Charging forward at someone

To charge forward, we need to tell the Envirocar to drive forward, then wait for 10 seconds, and then tell it to stop. Sound familiar? That’s because it’s basically the same as what we did in the first part of Exercise 2.

First, set the Icon Category to Library: envirocar.h. Add the Forward icon after the Wait For icon.

Change the Icon Category back to Flow Control, and add a Wait icon (not another Wait For icon) after the Forward. Adjust its settings so that it will wait for 10 seconds.

Go back to the Library: envirocar.h category. Add the Stop icon after the Wait icon.

The program should now look like this:
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Step 19:  Giving time to set the prank

We could try the program now, but how would we put the robot in place? It’d charge at us as soon as we turned it on. No fun in that!

The best way to fix this is to put in another Wait icon at the start of the program. If we tell the Envirocar to wait for 10 seconds at the start of the program, we have 10 seconds before it will start waiting for light. This would give us 10 seconds to shut the door after turning it on.

Add another Wait icon (not Wait For) from the Flow Control category. Put it right at the start of the program (by dropping it onto the Main icon). Set it to wait for 10 seconds.

Step 20:  Downloading and running the program

The program is now complete, and can be downloaded to the robot. Connect the robot to the computer, then choose the appropriate option from the Compile and Download With … list.

Some adjustment to the robot will probably be needed to make it detect light and dark properly. To adjust its sensitivity we use the trimpot, which looks like this:

[image: image31.jpg]



To turn the trimpot, you may need a screwdriver. Turning the blue part one way will make the robot less sensitive, and turning it the other will make it more sensitive. Try turning it to various angles until the robot stays off when you cover its light sensor, and turns on when you uncover the sensor.

You might also need to change the angle of your light sensor. It works best if it’s pointing upwards at roughly 45 degrees.

Result:

Find a cupboard, and hide the Envirocar in it. Turn it on, and close the door. Then, get someone to open the door, and watch as they get a surprise!

Instead of a cupboard, you might want to use a cardboard box. It will look a bit less suspicious if you seal the top of it, and cut the bottom out. Write Fragile on it, put in somewhere, and then stand back and wait. Be warned though, people might step on the box and break the robot, so be careful!

That’s it for this exercise, and hopefully you now have an idea of how a program can detect and respond to the world around it. We’ll do more on this in the next exercise, when we make a line following program.

Make sure you save your program from this exercise; it’ll be needed later on!

Step 21:  Making noise with a buzzer (Optional)

Does your robot have a buzzer on it? Some kits come with a buzzer than is fitted to work area 5. If it does, it’s easy to make the robot more startling by having the buzzer come on when it emerges from a cupboard!

The easiest way to make this happen is to replace the Wait 10 s icon with a suitable Pulseout icon.

Delete the “Wait 10 s” icon. Replace it with a Pulseout icon. The buzzer is attached to pin GPIO.5 of the Envirocar’s processor, so tell the Pulseout to pulse GPIO.5 for 10 seconds.

Your program should now look like this:
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Download the program, and see if it makes a dreadful noise when it comes out of the cupboard!

Another possible way to make sound is using the Tone icon. First, you need to tell GCGB where the buzzer is attached, by going to Program > Hardware Settings. On the Device Settings area on the right hand side of the window, choose the “Sound” device. Set the Output Pin to GPIO.5, then click OK to close Hardware Settings. Now, you can tell the Tone icon what frequency to make, and how long to make it for – this will let you play musical notes!

Exercise 4: Creating a line following program

Aim:

In this exercise, we’ll make the Envirocar follow a line marked on the ground with tape.

The robot will use its light sensor to detect if it’s over the line or the floor. If it’s on the line, it will turn on one motor, and if it’s not on the line, it’ll turn on the other. By doing this repeatedly, it can zig-zag its way along the line.

We’ll also make the robot wait until its button is pressed before starting.

Step 22:  Making a new program

To start with, create a new program. Add the library for the Envirocar, and then save the program

Step 23:  Turning on the headlights

Next, we need to turn on the headlights of the Envirocar, so that it can see the line. In previous exercises, we used the PulseOut icon to turn the lights on for a certain length of time. However, this time we need to turn the lights on, and then leave them on when the robot moves on to the next icon.

 The best way to do this is with the Set icon – this will turn something on the robot on or off, and then leave it on. Select the Input/Output category, and then drag out the Set icon and drop it at the start of the program. Set the Bit to Headlights, and the Status to On.

Step 24:  Waiting for the button to be pressed

Once the headlights have been turned on, we want the robot to wait until its button has been pressed before driving. There are two reasons for this: It gives everyone an easy to press start button for racing, and it also stops the motors from being turned on at the start of the program. (Remember, this causes electrical interference and makes it hard to put a new program on the robot!)

We could use a Wait For icon like in the last exercise, and set it so that it will wait for the button to be pressed. However, this is already a WaitForButton icon in the Envirocar library, which is easier to use.

Open the “Library: envirocar.h” icon category, drag the WaitForButton icon out, and drop it in after the Set icon.

Step 25:  Adding the main loop

The robot will need to keep checking to see if it can see the line, so we’ll need to create a loop, and put the checking code inside of it. The robot should keep running the code as long as it is turned on, so we’ll need a Do Forever icon.

Select the Flow Control category, and drag out a Do icon. Set the mode to Forever, leaving the condition blank.

The program should now look like this:
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Step 26:  Making a decision

Now that we have the setup code and the main program loop written, we need to think about what goes inside the main loop.

We need the robot to run one of two sections of code, depending on whether a particular condition is true. The best icon for this is the If icon.

Choose the Flow Control category, drag out an If icon and drop it in between Do and Loop. Notice that If also has a matching icon – End If:
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As with the Wait For icon, we can give the If icon a condition. The icons between If and End If will only be run if the condition is true.

We want the code to run when the light sensor (LDR) sees light. So, we need to come up with a condition that will be true when the light sensor (DigitalLDR) sees (is equal to) light (LIGHT).

With the If icon selected, click on the Edit button for the condition. This will open the Parameter Editor.

Try to remember how to use the Parameter Editor from the last exercise. If you can’t quite remember, have a look back a few pages – we need to make exactly the same condition as in the last exercise.

If you click all of the right buttons in the Parameter Editor, the program should now look like this:
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Step 27:  Making the opposite decision

We now have an If in the program, and the icons between If and End If will run only if the condition is true. But we also need a place to put icons that will only run when the condition is false.

This can be done using the Else icon. Choose the Flow Control category, and scroll down through the list until you see the Else icon. Then, drop the Else into the program between the If and the End If. (If you try to put the Else somewhere that isn’t between If and End If, an error message will come up.)

With the Else icon added, the program should look like this:
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Now, we have two places to put the icons. Anything that is between If and Else will only run if the condition is true (if there is light). Anything between Else and End If will only run if the condition is false (if there is no light).

Step 28:  Adding the motor controlling icons

Our line following program is almost done, except for one detail: It can’t actually drive yet!

Select the Library: envirocar.h category. Add a TurnLeft icon between the If and Else, and a TurnRight icon between the Else and the End If.

Now, the robot should be able to turn left when it sees the line, and right when it doesn’t.

Step 29:  Downloading and Testing

Download it to the robot, and see what happens! It should now be able to follow the line.

As with the Envirocar in a box program from the last exercise, you might need to adjust the trimpot on the robot to calibrate it. One motor should run when the LDR is on the line, and the other should run when the LDR is not on the line.

Make sure you save your program: it will be needed again in the next exercise.

Exercise 5: Improved line following

Aim:

In the last exercise, we made a line following program. However, it may not have worked as well as we’d hoped! The Envirocar can drive very fast, and sometimes it drives too fast to see the line properly. To make it follow the line more accurately, we need to slow it down a bit. After all, in line following competitions, leaving the line, and crashing into things doesn’t usually result in winning!

Step 30:  Copying the old line following program

Rather than making another line following program from scratch, we’ll adapt the old one. Open up the program from the last exercise, and then click File, then Save As. Save the program with a new name so the old one is left as it was.

Step 31:  Remove the TurnLeft icon

Delete the TurnLeft icon from between the If and the Else by clicking it and pressing the Delete key.

Step 32:  Add a SetMotors icon

Select the Library: envirocar.h icon category. Find the SetMotors icon, and add it to the program between If and Else (where the TurnLeft icon was). The program should look like this:
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Notice that SetMotors has two settings – LeftSpeed and RightSpeed. If the speed for a particular motor is 0, the motor will turn off, and if it’s 100, the motor will run at full speed. Forward, TurnLeft and TurnRight always run the motors at full speed.

We need to change the settings on the SetMotors icon so that it will make the robot turn to the left. Remember how the Envirocar steers? To turn left, it needs to stop the left motor and turn only the right motor.

Type 0 into the LeftSpeed box to stop the left motor.

Now we need to set a speed for the right motor. We want it to turn, but not too fast. For now, type 75 into the RightSpeed box.

Step 33:  Controlling the other motor

We now need to replace the TurnRight icon between Else and End If with another SetMotors icon, and set it so that it will make the robot turn right.

Delete the TurnRight icon. Then, drag out another SetMotors icon, and drop it where the TurnRight icon was.

This time the SetMotors icon needs to turn right, so it needs to stop the right motor while driving the left motor. Set RightSpeed to 0, and LeftSpeed to 75. The program should now look like this:
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Step 34:  Testing and fine tuning the program

Download the new line following program to the robot, and give it a try. Does the robot follow the line more reliably?

If the robot still doesn’t follow the line accurately, try reducing the speed further. Try changing it so that the motors run at 50 instead of 75. If it does follow the line well, try increasing the speed a bit (try 80 or 90).

Result:

The Envirocar should now be able to reliably follow a line. For best results, use the widest line possible, and make sure there is good contrast between the line and the surface the line is on. Masking tape on dark flooring tends to work well, as does black cloth tape on white tables.

Make sure you save your program from this exercise; it’ll be needed later on!

Exercise 6: Counting button presses

Aim:

In this exercise, we’ll make the Envirocar count how many times its button is pressed, and then flash its headlights back the same number of times.

Step 35:  Create a new program

Make a new program, add the Envirocar library, and then save the program somewhere safe.

Step 36:  Set aside a memory location to store the count

The robot will need to remember how many times its button has been pressed. In order to do that, we will need to set aside a small section of the robot’s memory (RAM) to store the count. In programming, a memory location used to store something is known as a variable.

To create a variable, you’ll first need to open the Variables window. Click on the Program menu, then click Variables. This window will open:
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At the moment, the list of variables is empty. We need to add one, so click on the Add button. The Add Variable window will appear:

[image: image40.png]Add Variable

Tope
O
@bpte

Oword

O ntsger
O sting

Onay
Size: =





We need to give the variable a name. Variable names should include only letters and numbers – no spaces! This variable will be used to store a count, so let’s call it Counter.

Don’t worry about the Type, leave it set as it is. 

(Different variable types can store different amounts of data, and use different amounts of memory. A Byte variable can store numbers between 0 and 255, and uses only 1 byte of RAM. A Word variable can store numbers between 0 and 65535 and uses 2 bytes of RAM. So normally, we use a Byte variable to save RAM, unless we need the variable to hold a bigger number. If you click the question mark button, then click on a data type in the list, a description of it will be shown.)

Click OK to close the Add Variable window and create the new variable. The list of variables should now have our new variable in it:
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Click OK to close the Variables window.

Step 37:  Adding the main loop to our program

As with most programs, we will need to create a main loop that keeps running while the Envirocar is turned on. Select the Flow Control category, and add a Do loop. Make sure it is set to repeat Forever.

Step 38:  Adding a Set Variable icon

To store a number in the variable, we need to use the Set Variable icon.

Change the category to Variables, then drag out the Set Variable icon and drop it inside the main loop. The program should look like this:
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Notice the settings for the Set Variable icon. The first setting, Variable, allows us to choose the variable we will set. We want to set Counter, so click the down button and choose Counter from the list.

The other setting, New Value, is where we can say what the variable should be set to. There are several things that can be put here – we could put in another variable (which would copy the value), a number, a calculation, or a function. In this case, we need to use a function.

A function is similar to a variable, except that it has some icons inside it. Whenever we try to read the value of a function, the icons inside it will run, and they will change the value.

The Envirocar library includes a function that we will use. The function is called CountPresses (like a variable, spaces aren’t allowed in the name of a function). CountPresses has some icons inside it that will count how many times the button is pressed. When the button hasn’t been pressed for a second, the icons inside CountPresses will set the value of CountPresses to the number of times that the button has been pressed. Then, the Set Variable icon will copy that number into the Counter variable, and Counter will store the number of presses.

To choose the function, we will use the Parameter Editor. Click on the Edit button for New Value, and this window will open:
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The first page of the Parameter Editor shows all of the things that we could copy into the Counter variable. We want to run a function from a library and use its result, so click on Function. Click next to go to the next page, which looks like this:
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There is only one function to choose from – the CountPresses function. Click on it, and its settings will appear on the right hand side of the screen:
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We don’t need to put any value in the box for Timeout. The default value (the value that will be used if nothing is put in the box) is 1000 ms or 1 second, which is about the right length of time.

Click Finish to exit the Parameter Editor. The program should now look like this:
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The Set Variable icon is now finished. When the icon runs, it will count how many times the button is pressed, then copy the count into the variable Counter.

Step 39:  Adding a repeat icon

We now need to add some icons that will flash the lights the same number of times as the button is pressed. To do this, we’ll need a loop.

Since we need to repeat something a certain number of times, but don’t need a counter to keep track of how many times it has repeated so far, the Repeat loop is the best option. Select the Flow Control category, and then add a Repeat loop after the Set Variable icon.

The Repeat icon has one setting – Repetitions. Here, we say how many times we want the icons in the loop to be repeated. We want the icons to repeat as many times as the value in the Counter variable, so click the down arrow, and choose Counter from the list.

The program should now look like this:
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Step 40:  Flashing the headlights

As we’ve done many times before, we need to flash the headlights.

Add a Pulseout icon and a Wait icon inside the Repeat loop. Set the Pulseout icon to pulse the headlights, and set both icons to delay for 500 ms. That way, each flash of the headlights will take 1 second (500 ms on, 500 ms off).

The program should have these icons in it:
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Step 41:  Programming

Attach the robot to the computer, and then download the program. (If you press F9, the program will be downloaded using the last programmer you used).

Results:

The robot should flash its headlights once for every time you press the button. For example, if you press the button once and then wait, the lights will flash once. Press the button four times and wait, and then the lights will flash 4 times.

In the next exercise, we’ll combine this button counting code with the Envirocar in a box program and the line following program. This will allow us to choose a program on the Envirocar without having to reprogram it.

Exercise 7: Combining the programs

Aim:

In this exercise, we’ll combine several of the past programs we’ve created into one. This will then allow us to choose a different program on the Envirocar by pressing the button a certain number of times.

Step 42:  Copying the counting program

Rather than starting from scratch, we’ll reuse the button counting program from the last exercise. Open it (if it isn’t already open), then click File, then click Save As. Save it somewhere safe with a new name.

Step 43:  Adding a subroutine for line following

In this step, we will create a subroutine for following lines.

A subroutine is like a miniature program, which our main program can run any time it needs to. We can take any frequently used code, and put it into a subroutine. Then whenever we want to use the code from the subroutine, we just have to add a single icon to run the subroutine.

Notice the Subroutine/Function panel in the top right of the GCGB window:
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At the moment there is only one subroutine in the program – the Main subroutine, which is where we’ve been putting all of our code.

We’ll add a new subroutine to follow a line. Click on the Add button in the Subroutines/Function panel, and the Add Subroutine window will open:
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There are many options on the Add Subroutine window, but most of them don’t matter now. All that we need to do is give the subroutine a name.

Type FollowLine into the Name box, then click OK. The main window will now show the contents of the new subroutine:
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There isn’t anything in the new subroutine at the moment, but we will change this shortly.

(Don’t worry about the subroutine parameters. If we were making a more complicated program, we might put some parameters here. Then, we would be able to use them just like variables inside the subroutine. When we added an icon to run the subroutine, the list of parameters would be displayed in the icon settings area. But we don’t need to do this; the subroutine will only do one thing!)
Step 44:  Adding a surprise subroutine

We need to add another subroutine to the program – one to hold the Envirocar in a box program.

Click on the Add button in the Subroutine/Function panel. The Add Subroutine window will appear again. Type “JumpOut” into the name box, and click OK.

Click on Main in the list of subroutines to go back to the main routine. The window should look similar to this:
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Before we go any further, make sure that you have 3 things shown in the list in the Subroutine/Function panel: Main, FollowLine, and JumpOut. If you’re missing any, make sure that you added the subroutines properly.

Step 45:  Opening the original programs

Now, we need to open the original Envirocar in a box and line following programs. Great Cow Graphical BASIC can display several windows at once within its main window, and we will make use of this to allow us to have our programs side by side.

Click on the Restore button for the program window. That’s this button:
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Once you’ve done that, the program window will shrink, and you’ll see any other programs that are open. In this photo, there is a new blank program, and the press counting program:
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What you do now will depend on what you have open. You need to have the new button counting program, the line following program, and the Envirocar in a box program open. Anything else should be closed.

You can close an individual program by clicking on its close button.

You can open a new program by clicking on File, and then clicking Open. When you open a program, it will automatically take up the whole outer window – click its Restore button to shrink it down again.

Once you have the 3 programs open, you can move on to the next step.

Step 46:  Copying the Envirocar in a box program

Now, we will copy the icons from the Envirocar in a box program to the JumpOut subroutine of the button counting program.

Go to the new button counting program, and make sure that the JumpOut subroutine is being shown. If it isn’t, click on JumpOut in the Subroutine/Function panel to select it.

Bring the Envirocar in a box program to the front of the screen (click on any part of it you can see). Move the windows around so that you can see the JumpOut subroutine underneath, like in the picture below:

Click on the first icon (the Wait 10 s icon) to select it. Then, scroll down in the program. Hold down the Shift key, and click on the last icon (the Stop icon). There should now be a black box around every icon in the program:
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Now, drag the icons across from the Envirocar in a box program, and drop them into the new button counting program under JumpOut. You can drag any one of the icons with a box around it. If you dragged the icons properly, they should now be in the JumpOut subroutine:
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We can now close the Envirocar in a box program – we don’t need it now that we’ve copied all of its icons.

Step 47:  Copying the line following program

Go to the new button counting program, and select the FollowLine subroutine.

Click on the line following program to bring it to the front of the screen. Move it so that you can see the FollowLine subroutine of the button counting program as well.

As with the last step, we need to copy all of the icons from the line following program into the button counting program. Click on the first icon in the line following program (Set Headlights On). Then, scroll down to the bottom. Hold down the Shift key, and click on the last icon (the Loop icon).

Drag the icons out from the line following program, and drop them into the FollowLine subroutine.

The programs should now look like this:
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We don’t need the line follow program any more, so it can be closed. Click the maximise button (circled above) to make the button counting program fill the screen.

Step 48:  Adding If icons to the new main program

At this stage, your program’s Main routine should be identical to the one from the last exercise, and you should have the two subroutines added. What we need to do now is add the icons to make the main routine run the subroutines depending on how many times the button is pressed.

Now, we’ll add a couple of If icons. We’ll make one check if Counter is equal to 1, and the other check if Counter is equal to 2.

Make sure the Main routine is showing. Choose the Flow Control category. Drag out an If icon, and drop it after the End Repeat icon.

Click on the Edit button for Condition. When the Parameter Editor opens, choose Simple Condition. Set the first value to Counter (it will be in the list, click the down arrow), and type 1 into the second value box. Close the Parameter Editor.

The program should now look like this:
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Now, we need to add a second If. We will copy the existing one, then edit it to make it check if Counter is equal to 2.

Click on the If. Then hold down Shift and click on the End If. A rectangle will appear around each of the icons. Hold down the Shift, then drag the If, and finally drop it under the End If. 

Click on the new If, then click inside the Condition box so that you can type in it. Change the 1 to a 2. The Ifs should look like this:
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Step 49:  Running the subroutines

We can now add the icons to run the right subroutines.

Change the icon category to Subroutines. There should be 2 icons in the list: one for FollowLine, and one for JumpOut.

Drag out the icon for FollowLine, and drop it between the first If and End If. Drag out the icon for JumpOut, and drop it inside the second If.

If your program looks like this, you’re all done:
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Step 50:  Downloading

Connect your robot to the computer, and download the program.

Result:

When you first turn the robot on, it will do nothing. If you press the button once, the lights will flash once, and then stay on. Press the button again, and the line following will begin.

If you press the button twice, the lights will flash twice and then the hiding program will begin. Put the robot somewhere and shut the door! Once it’s chased someone, it will go back to waiting for another button press or two.

And that’s it! Now your robot can do everything you’ve programmed it to at the press of a button! Well done!
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